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Introducció

Per treballar a l’àmbit de l’animació 3D primer cal familiaritzar-se amb les eines
i tècniques principals que es fan servir. La finalitat d’aquesta unitat és proveir
aquest context i introduir algunes operacions bàsiques com la translació, la rotació
i l’escalat d’objectes.

En l’apartat “Entorn i eines per a l’animació 3D” es presenten les tècniques
més esteses actualment des d’un punt de vista genèric, és a dir, sense centrar-nos
encara en cap programari en concret. Tots els conceptes els trobareu a Maya, que
serà el programari de referència.

Dins d’aquest apartat hi ha una secció a parlar de l’espai 3D, és a dir, el marc
matemàtic on es desenvolupen les animacions, i s’introdueixen conceptes com
base, *sistema de referència i coordenades.

L’apartat “Tècniques de moviment, rotació i escalat d’objectes” se centra en
Maya i es dedica una secció a explicar les diferents eines per posicionar objectes
a l’escena, aprofundint en el concepte de transformació.

L’important al primer apartat és copsar els conceptes, ja que aquests s’amplien tant
en aquest com en d’altres mòduls, i al segon, adquirir una certa agilitat a l’hora de
manipular els objectes a Maya.
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Resultats d’aprenentatge

En finalitzar aquesta unitat, l’alumne/a:

1. Anima fotogrames per ordinador en 3D a partir de la interpretació del guió,
per aconseguir l’expressivitat requerida, aplicant tècniques d’animació i analitzant
característiques expressives.

• Temporitza els moviments de tots els elements 3D que s’animaran, indicant
el nombre de fotogrames necessari per a cada variació i generant una carta
d’animació per a cada pla, personatge i/o decorat.

• Realitza l’animació dels elements 3D en els seus moviments genèrics
mitjançant la interfície d’animació, amb l’expressivitat adequada i adaptant-
se als temps requerits.

• Realitza l’animació dels elements 3D en els seus moviments secundaris,
específics i parts toves, amb l’expressivitat adequada mitjançant la interfície
d’animació.

• Realitza les sincronitzacions de moviments necessàries per aconseguir
transmetre major sensació de realisme i versemblança a l’animació.

• Sincronitza l’animació 3D amb la banda sonora i el doblatge original així
com amb els efectes.

• Anima les càmeres 3D i els seus paràmetres.
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En el punt “Forma de
distribució” d’aquest
apartat s’estudien els
programaris generalistes.

La interpolació és una
operació matemàtica que
serveix per generar punts
intermedis entre dos punts
coneguts.

1. Entorn i eines per a l’animació 3D

Les eines a disposició per produir animacions en 3D implementen diferents
tècniques que és necessari conèixer, tant les tècniques comunes presents a la
majoria de programaris com les tècniques avançades que només trobarem a
programaris específics.

També és necessari tenir algunes bases teòriques per entendre el funcionament
intern dels programaris 3D i les operacions que fan a l’espai 3D. Així doncs cal
repassar conceptes com sistema de referència i coordenada.

Com que el grafisme es complementa amb so per produir les seqüències animades,
també cal tenir uns mínims coneixements teòrics d’aquesta àrea.

1.1 Programari d’animació 3D

El programari d’animació 3D és tot el programari per produir animacions.
Donat que al mercat hi ha una àmplia oferta, cal conèixer els punts forts i quines
tècniques implementen per triar el més adient a cada projecte.

És poc probable que un únic programari serveixi per cobrir totes les necessitats
d’un projecte mínimament complex, així que la situació habitual és la combinació
de diferents programaris per obtenir el resultat. Per aquest motiu, és important
conèixer com fer interoperar els programaris entre si, utilitzant formats de fitxer
d’intercanvi i tècniques com el cuinat.

1.1.1 Tècniques bàsiques o d’ús comú

Tot i que cada programari les implementa d’una manera lleugerament diferent,
històricament s’han anat introduint tota una sèrie de tècniques que han esdevingut
d’ús comú.

Les tècniques bàsiques són les que, per una banda, estan disponibles a tots els
programaris d’animació 3D generalistes i, per l’altra, permeten tractar qualsevol
tipus d’animació feta amb qualsevol altra tècnica.

Fotogrames clau (’keyframes’)

L’animació per fotogrames clau (keyframes) és la tècnica més bàsica de totes i
que es troba amb més seguretat a qualsevol programari d’animació 3D. Aquesta
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Altres propietats del pare
com la visibilitat també

poden afectar la
descendència, tot i que això

depèn del programari
concret que utilitzem.

El procés de fer l’assignació
de cada vèrtex amb el seu

os es diu rigging.

tècnica consisteix a establir el valor d’una o més propietats del model en un
instant A, uns altres valors en un instant B, i deixar que sigui l’ordinador qui
interpoli els valors intermedis en l’interval entre A i B.

Vegeu la figura 1.1 com a exemple d’animació per interpolació.

Figura 1.1. Animació per fotogrames clau

Jerarquia

En tot programari d’animació 3D s’admet algun tipus de jerarquia entre objectes.
La jerarquia és un tipus de relació entre objectes en què uns elements són fills
d’altres, de manera que qualsevol translació, rotació o escalat aplicat a l’objecte
pare afecta també els fills. L’aplicació principal d’aquesta tècnica és animar
objectes articulats.

Vegeu un exemple d’ús de la jerarquia en la figura 1.2.

Exemple de braç robòtic

En la figura figura 1.2 quan es trasllada l’objecte que fa de base del braç robòtic es
traslladen també els objectes B, C i D, ja que són descendents seus a la jerarquia. Si
gireu l’objecte C, indirectament fareu rotar també l’objecte D.

Figura 1.2. Jerarquia
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Vegeu el paper de les
targetes gràfiques a
l’animació 3D en el punt
“Maquinari” d’aquest
apartat.

’Skinning’

La tècnica d’skinning s’utilitza per simular la deformació de les parts toves quan
interactuen amb les articulacions d’un cos, associant cada vèrtex a un o més ossos
amb una certa intensitat. S’aplica sobretot a personatges.

Vegeu un exemple d’ús en la figura 1.3.

Figura 1.3. ’Skinning’

És una tècnica que comporta un cert cost computacional, tot i que qualsevol
targeta gràfica disposa de potència suficient per previsualitzar-la en temps real.
També poden haver-hi limitacions quant al nombre d’ossos simultanis que poden
afectar un vèrtex concret, especialment en models per a videojocs.

Animació per vèrtex

Els vèrtexs d’un objecte no s’animen individualment si no és necessari. La raó és
que fer una animació vèrtex per vèrtex comporta un cost en espai d’emmagatze-
matge i memòria que pot arribar a ser molt alt, ja que s’han d’emmagatzemar
individualment les posicions, orientacions i escales de cada vèrtex al llarg de
l’animació. Tot i així, per animar certes deformacions, com en el cas d’un teixit
(vegeu la figura 1.4), pot ser necessari fer una animació vèrtex per vèrtex.

Figura 1.4. Animació per vèrtex
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’Blendshapes’

Com que animar els vèrtexs individualment produeix animacions molt costoses
d’emmagatzemar, hi ha una tècnica, típicament aplicada a l’animació facial, que
consisteix a definir uns conjunts anomenats blendshapes. Els blendshapes
contenen una forma concreta de la malla, és a dir, les posicions individuals de cada
un dels vèrtexs. Una vegada definida una sèrie de blendshapes, es fa el càlcul per
interpolació per tal d’obtenir formes intermèdies.

Vegeu l’exemple i la figura 1.5 que il·lustren l’ús de la tècnica amb blendshapes.

Exemple d’animació d’expressió facial amb ’blendshapes’

A partir del model d’un cap de la figura figura 1.5, es poden definir dos blendshapes (A i B).
Al punt A els vèrtexs conformen una expressió alegre a la cara i al punt B conformen una
expressió trista. Una vegada definits, l’ordinador calcula les expressions intermèdies entre
un i altre, per obtenir una expressió neutra al punt mitjà.

Figura 1.5. ’Blendshapes’

1.1.2 Observacions sobre les tècniques bàsiques

La importància de les tècniques bàsiques resideix en el fet que es pot tractar
qualsevol animació produïda amb qualsevol altra tècnica, ja que tota animació
consisteix en:

• Sèrie de canvis en la posició, orientació i escala dels objectes, que es poden
definir amb fotogrames clau.

• Possibles deformacions, que es poden tractar animant els seus vèrtexs.

1.1.3 Tècniques avançades

El treball d’animació seria molt costós només amb tècniques bàsiques, així que al
llarg del temps s’han creat altres tècniques avançades que simplifiquen i agilitzen
la generació de certs tipus d’animacions.
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La cinemàtica és una
tècnica a mig camí entre
bàsica i avançada.

Cinemàtica inversa

La cinemàtica inversa consisteix que el programari calculi la posició i rotació
de cadascun dels objectes d’una jerarquia per tal que l’extrem quedi en posició
i orientació concretes. Dit d’una altra manera, es posiciona l’objecte final de la
jerarquia i l’equip orienta automàticament la resta. Vegeu la figura 1.6, on l’usuari
només ha de moure el punt per animar el braç robòtic.

Figura 1.6. Cinemàtica inversa

És un sistema força pràctic per manipular extremitats de personatges com braços
o cames sense haver de preocupar-se de posicionar una a una cada articulació, tot
i que, per contra, per la naturalesa dels càlculs es poden produir inestabilitats en
l’animació, especialment en punts on hi ha múltiples solucions.

Podeu veure un exemple real de l’ús d’aquesta tècnica al següent vídeo:

https://player.vimeo.com/video/246937666

Restriccions

Les restriccions són un cas similar a la cinemàtica inversa, però una mica més
general. Les restriccions exigeixen que els objectes mantinguin una certa posició
i orientació, inclús si formen part d’una jerarquia. Aquestes restriccions poden ser
de diferents tipus:

• Mantenir l’orientació cap a un objecte.

• Mantenir-se sobre una superfície.

• Mantenir-se sobre una línia.

Exemple de control de la mirada amb restriccions

Per fer que els ulls d’un personatge sempre apuntin a un punt concret es pot fer amb
restriccions, tal com presenta la figura 1.7, en què només amb el moviment del punt els ulls
del model segueixen la direcció apuntada.

https://player.vimeo.com/video/246937666
https://player.vimeo.com/video/246937666
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Figura 1.7. Restriccions

Sòlids rígids

És força habitual que per fer certes animacions simplement cal que els objectes
segueixin les lleis de la dinàmica newtoniana. La simulació de sòlids permet
configurar les masses i altres propietats físiques dels objectes i deixar que sigui
l’ordinador qui generi l’animació.

Vegeu-ne un exemple en la figura 1.8.

Figura 1.8. Sòlids rígids

Dins de la simulació d’objectes sòlids, els sòlids rígids es caracteritzen perquè
són indeformables i es mouen lliurement o bé són inamovibles. Aquestes
característiques permeten fer una sèrie de simplificacions en el seu càlcul que
fan que sigui relativament poc costós, tot i que depèn fortament de la quantitat de
polígons que tingui cada objecte i, en menor grau, del nombre d’objectes.

Actualment objectes com pedres, maons i trossos de paret se simulen en grans
quantitats com sòlids rígids al cinema d’acció i fantasia. Visualitzeu el vídeo
següent:

https://www.youtube.com/embed/HnAw3E_mLh8?controls=1

En l’àmbit pràctic, podeu veure un exemple d’ús d’aquesta tècnica al següent
vídeo:

https://www.youtube.com/embed/HnAw3E_mLh8?controls=1
https://www.youtube.com/embed/HnAw3E_mLh8?controls=1
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https://player.vimeo.com/video/246937738

Objectes tous

Els objectes tous són sòlids que segueixen les lleis de la dinàmica newtoniana,
però a diferència dels sòlids rígids poden patir deformacions. Alguns exemples
serien objectes com la tela, els coixins o la bandera de la figura figura 1.4. El cost
computacional d’aquests tipus de simulacions és força més alt que la simulació de
cossos rígids, ja que els càlculs en aquests tipus de simulacions s’han de fer vèrtex
per vèrtex i no admeten les mateixes simplificacions que es poden fer en el cas
dels rígids, com assumir que sempre ocupen el mateix volum a l’espai.

Cabells i vegetació

Cabells i vegetació són un tipus particular d’objectes tous deformables. Es
caracteritzen per compondre’s d’una gran quantitat de petits objectes distribuïts
per sobre una superfície. Vegeu la figura 1.9.

Figura 1.9. Cabells

Aquests objectes comparteixen característiques comunes com tenir una certa
longitud o rigidesa i estar afectats per fenòmens comuns, com per exemple el
vent simulat. Això fa que es puguin calcular més ràpidament considerant-los
no individualment, sinó com a part d’un conjunt. Tot i que comporten una
gran quantitat de càlculs, els programaris els poden simular amb força eficiència,
especialment si el càlcul es fa fent servir la GPU.

Partícules

Els efectes de partícules són un cas similar als cabells i la vegetació en el sentit
que suposen animar un conjunt molt nombrós de petits objectes que tenen un
comportament similar. Es fan servir per simular fenòmens com les espurnes d’una
soldadora o uns focs artificials (vegeu la figura 1.10).

https://player.vimeo.com/video/246937738
https://player.vimeo.com/video/246937738
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Figura 1.10. Partícules

Cada partícula individual se simula amb un objecte senzill (per exemple, piràmi-
des, petites esferes o cubs) i habitualment es poden configurar paràmetres com el
nombre de partícules per segon emeses. Una vegada generades, les partícules
segueixen les lleis de la dinàmica newtoniana o diferents comportaments que
podem definir i que normalment inclouen un cert grau d’aleatorietat.

Fluids

Els fluids es poden considerar un cas particular de partícules, tot i que en aquest
cas es genera una malla de polígons que envolta les partícules per simular la
superfície del líquid (vegeu la figura 1.11).

Figura 1.11. Fluids

El comportament dels fluids, incloent-hi aquí líquids i gasos, és extremadament
costós de calcular i requereix un programari força sofisticat i que aprofiti molt bé
les capacitats de l’equip en què s’executa.

Sistemes basats en agents

Animar individualment cada membre d’una multitud d’individus pot comportar
un cost en temps inassumible per a qualsevol equip d’animadors. Alguns casos
senzills, com una bandada d’ocells, es poden simular fent servir partícules, però
si els individus tenen un comportament complex (si han d’esquivar obstacles o
interaccionar entre ells) s’ha de fer servir un sistema basat en agents.

Vegeu-ne un exemple a la figura 1.12.



Animació 2D i 3D 17 Programari d’animació 3D

Per tal de previsualitzar
aquests tipus d’animacions
és important que la targeta
gràfica admeti l’ús
d’instàncies.

Vegeu l’explicació extensa
a la unitat de “Sistemes de
captura de moviment”.

Figura 1.12. Agents

Un dels primers usos notables d’aquesta tècnica el trobem a l’escena de l’estam-
pida d’El Rei Lleó:

https://www.youtube.com/embed/XM_VHtSDMIQ?controls=1

Per definir una animació en aquests sistemes hem d’establir normes generals que
han de complir els agents. Per exemple, quina és la distància mínima que han de
respectar entre ells, si han de mantenir l’objectiu d’arribar a un cert punt o si la seva
velocitat s’ha de mantenir dins d’uns marges. Aquest tipus de programari té una
forta relació amb tècniques d’intel·ligència artificial, especialment el pathfinding,
que s’utilitza per calcular els camins de cadascun dels agents de manera que arribin
al seu objectiu sense col·lidir entre si o amb l’escenari.

Captura de moviment

Si hi ha prou pressupost, una opció per tal d’assegurar uns moviments precisos i
naturals a una animació és capturar-la directament d’un actor. En aquest cas es
rep una informació precisa de la posició i l’orientació de cadascuna de les seves
articulacions, o dels punts de control en el cas que es tracti d’una animació
facial.

Tot i que aquesta informació és força precisa normalment és necessari fer-la passar
per un procés de filtratge que suavitzi les inestabilitats que es produeixen en la
captura. Addicionalment, una vegada feta la captura sovint s’ha de fer una labor
d’adaptació de l’animació per tal d’aconseguir el resultat desitjat.

https://www.youtube.com/embed/XM_VHtSDMIQ?controls=1
https://www.youtube.com/embed/XM_VHtSDMIQ?controls=1
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1.1.4 Observacions sobre les tècniques avançades

Mentre que les tècniques bàsiques són presents a la gran majoria de programari
d’animació 3D generalista, les tècniques avançades sovint van de forma separada
en aplicacions independents o plug-ins. La raó és que el seu desenvolupament
comporta un esforç tècnic considerable i les solen desenvolupar grups i empreses
independents.

Entre els diferents programaris que implementen una mateixa tècnica, pot haver-
hi unes diferències significatives quant al rendiment, la completesa i la facilitat
d’ús. Cal conèixer aquestes diferències per tal d’escollir quins programaris convé
utilitzar en cada moment.

Per últim, el camp de les tècniques avançades està en constant evolució, de manera
que és important mantenir-se actualitzat pel que fa a les noves tècniques que
apareixen i les que esdevenen obsoletes tot seguint les notícies del sector.

1.1.5 Aspectes legals

Tant en el treball per compte propi com en la fase d’aprenentatge és important
conèixer la legislació que afecta l’ús del programari d’animació 3D per tal d’estal-
viar problemes legals. Tot i que el programari lliure sembla una forma d’estalviar-
se aquests problemes també cal tenir en compte que aquest pot comportar uns
costos ocults.

Propietat

El programari d’animació 3D es classifica en dos grups respecte a qui té la
propietat:

• Programari propietari: la propietat és d’una empresa que dona permís a
l’usuari per instal·lar-lo en un nombre determinat d’estacions de treball.

• Programari lliure: el programari no pertany a ningú i l’usuari pot instal·lar-
lo a tantes estacions com vulgui.

Ús

L’ús que es pot fer del material creat amb cada programari ve regulat pel tipus de
llicència. L’aspecte més important d’aquestes llicències és si admeten o no l’ús
comercial.

• Les llicències que admeten l’ús comercial permeten vendre allò produït amb
el programari.
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Hem fet una simplificació,
ja que hi ha molts tipus de
llicències de programari.
Si voleu informar-vos-en
en profunditat, consulteu
bit.ly/2A8AcvD.

• Les llicències que no admeten l’ús comercial no permeten obtenir un
benefici amb allò produït.

Relació entre propietat i ús

En general el programari propietari admet l’ús comercial, mentre que el progra-
mari lliure pot admetre o no l’ús comercial en funció del tipus concret de llicència
sota la qual es distribueix.

També és important remarcar que dintre del programari propietari hi ha versions
de prova per a estudiants que, tot i que no admeten l’ús comercial, sí que permeten
utilitzar els programes amb poques o cap limitació, sempre que l’usuari acrediti
estar cursant estudis relacionats amb el sector.

1.1.6 Cost

Quant al cost, el programari propietari té un cert cost per a l’usuari que depèn
del nombre d’estacions de treball en què s’instal·li. D’altra banda, el programari
lliure en principi no té cost, tot i que cal tenir en compte que el seu ús pot generar
despeses en conceptes com suport tècnic o formació.

Sistema de pagament per subscripció

Darrerament entre el programari propietari s’ha popularitzat el sistema de pagament per
subscripció en què la llicència d’ús del programari propietari s’abona mensualment, i això
facilita l’accés al programari per a petits empresaris i emprenedors.

1.1.7 Diferències entre sectors

Hi ha diferents sectors, o tipus d’activitats econòmiques, on s’utilitza animació
3D. És important conèixer quins són els programaris d’ús més estès en aquests
sectors per tal d’aprendre a fer servir les eines més adients.

Els sectors principals on s’aplica animació 3D són videojocs, cinema d’animació
i motion graphics.

Al sector dels videojocs el programari d’animació 3D forma part d’una cadena de
producció on l’últim element és el motor de joc, que és qui executa les animacions.
És molt important que el programari d’animació pugui exportar les dades en un
format que entengui aquest motor. Aquesta dependència del motor de joc fa que
sovint hi hagi una sèrie de restriccions respecte al que es pot o no es pot fer,
ja que el motor pot no funcionar amb totes les característiques que ofereix el
programari d’animació. En general l’animador treballa amb programadors que,
coneixedors de les possibilitats del motor, s’encarreguen d’informar-lo de quines

https://ca.wikipedia.org/wiki/Llic%C3%A8ncia_de_programari
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són les limitacions amb què ha de treballar, tot i que també pot negociar ampliar-
lo per tal que admeti característiques addicionals. En general les poligonitzacions
dels models i la complexitat de les animacions són més baixes en comparació amb
el cinema d’animació, tot i que aquesta diferència pot difuminar-se a les grans
produccions.

Al cinema d’animació en general el programari d’animació 3D té més prota-
gonisme, ja que l’animació no és un element més dintre de la producció sinó
l’element principal. En aquest cas no només és més probable que es puguin fer
servir totes les capacitats del programari sinó que sovint el programari d’animació
s’amplia amb mòduls fets a mida, ja que les productores d’animació contracten
programadors amb aquesta finalitat. Quant a la complexitat, els models que
s’utilitzen tenen poligonitzacions més altes i les animacions poden ser tècnicament
més exigents.

El sector del motion graphics comprèn animacions curtes que es fan per televisió
i internet. La característica principal del sector és que prioritza la productivitat, és
a dir, que tot i que cada animació individual no és gaire complexa, s’han de produir
moltes animacions. Això fa que es puguin utilitzar programaris d’animació més
econòmics en comparació amb la resta de sectors.

1.1.8 Maquinari

A l’hora d’adquirir un programari d’animació 3D és important consultar els
requisits recomanats de maquinari per tenir una idea aproximada del cost de
l’equip necessari. Tot i així, cal tenir en compte que en funció de les dimensions i
la complexitat del projecte poden sobrepassar les capacitats del maquinari i patir
problemes d’estabilitat tot complint els requisits recomanats.

És important fer proves de rendiment amb el programari abans de seleccionar-lo
per a un projecte concret o bé consultar experiències de primera mà del maquinari
usat per a projectes similars.

Dins de les diferents opcions disponibles és molt important destacar el paper que
tenen les GPU. Moltes simulacions en animació 3D són costoses en temps de
càlcul, especialment si impliquen una gran quantitat d’objectes.

Per la seva construcció, les CPU processen els objectes seqüencialment, encara
que en pugin tractar en paral·lel una certa quantitat segons el nombre de nuclis
de què disposen. Aquesta quantitat és baixa en comparació amb altres tipus de
processadors, és a dir, les CPU estan dissenyades per fer càlculs complexos sobre
un nombre moderat d’objectes.

Per processar molts objectes en paral·lel tenim les GPU. Aquestes disposen d’una
gran quantitat de petits processadors o shading units que els permeten tractar un
nombre massiu d’objectes en paral·lel. La contrapartida és que els càlculs que fan
per a cada objecte no poden ser gaire complexos.
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Dintre dels sistemes
operatius de programaris
lliures destaca Linux i les
diferents distribucions sota
les quals està disponible.

Vegeu la figura 1.13 per a les diferències entre CPU i GPU.

Figura 1.13. Diferència entre CPU i GPU

Les GPU són adients per tractar objectes com vèrtexs o cabells, ja que en aquest
tipus d’objectes els càlculs que s’han de fer per cada unitat són relativament
senzills, però s’han de tractar una gran quantitat d’unitats. Conscients d’això,
des de fa uns anys els fabricants han ampliat la funcionalitat de les GPU per tal
que puguin fer càlculs més enllà dels purament gràfics, incloent-hi càlculs físics
i inclús d’intel·ligència artificial. En general, sempre que hi hagi un conjunt gran
d’objectes per tractar i un càlcul senzill per fer per cada objecte, el càlcul es pot
fer més eficientment per GPU.

És important informar-se abans d’adquirir un programari. Per exemple, per a un
programari per fer càlculs físics cal saber si fa els càlculs per CPU o per GPU, ja
que en el segon cas podem beneficiar-nos d’uns temps de càlcul molt més baixos
si disposem d’un equip adient.

1.1.9 Sistema operatiu

La disponibilitat d’un programari d’animació 3D depèn també del sistema opera-
tiu.

Hi ha dos grans grups dintre del programari d’animació 3D. D’una banda, els
sistemes operatius de programari lliure i, de l’altra, els sistemes operatius de
programari propietari. La decisió d’utilitzar-ne un o un altre té les mateixes
implicacions que la diferència entre fer servir un programari d’animació propietari
o lliure.

Tot i que aquesta diferència va minvant, el programari lliure en general requereix
uns coneixements tècnics més alts per part de l’usuari o del responsable de
manteniment d’equips, factor que també s’ha de tenir en compte a l’hora d’optar
per aquesta solució.
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La simulació de fluids és un
cas típic de programari

especialitzat.

1.1.10 Forma de distribució

El programari d’animació es pot distribuir de diferents formes:

• Aplicació independent, és a dir, com un programa complet instal·lat a
l’ordinador.

• Plug-in, és a dir, com un complement instal·lat per fer-lo servir a una
aplicació.

• Mòdul dintre d’una aplicació, és a dir, com una part especialitzada dins
d’una aplicació.

Quan es distribueix com a aplicació, a més, es distingeixen dos grans grups: pro-
gramaris generalistes i programaris especialitzats. Els programaris generalistes
són com una gran caixa d’eines que ens serveix per a quasi qualsevol situació.
Implementen el que hem anomenat tècniques comunes i inclouen un ventall més
o menys gran de les tècniques avançades, sovint en forma de mòdul dins de
l’aplicació, tot i que normalment aquestes tècniques no són les millors disponibles
al mercat. La majoria de programaris generalistes, a més, poden ampliar la seva
funcionalitat amb plug-in.

Els programaris especialitzats són una eina per fer una tasca molt concreta i
presenten la situació contrària als programaris generalistes: implementen amb
molta qualitat principalment una sola tècnica, sovint alguna de les avançades, i
poden incloure també tècniques comunes, tot i que amb menys qualitat que en un
programari generalista.

És important distingir la diferència entre un mòdul i un plug-in. La diferència
principal és que el mòdul forma part de l’aplicació mentre que els plug-ins estan
formats per fitxers externs a l’aplicació que s’instal·len a part.

Quant a la interfície, els plug-ins solen presentar una interfície pròpia mentre
que els mòduls, com que estan integrats a l’aplicació, tenen una interfície més
similar a la resta de l’aplicació. Tot i així pot passar que alguns mòduls que en
origen han estat plug-ins o aplicacions independents que l’empresa fabricant del
programari generalista ha adquirit, retinguin part de la seva interfície original i
presentin peculiaritats a l’hora d’usar-los.

1.1.11 Interoperativitat

La interoperativitat entre dos programaris és la capacitat que tenen per intercan-
viar dades. En el cas de les animacions, per intercanviar dades en la direcció A
cap a B, o bé en la direcció contrària, tal com presenta la figura 1.14.
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Un exemple clar és
Autodesk.

Figura 1.14. Interoperativitat amb tècniques comunes

En general, en l’ús de tècniques comunes (per exemple, l’animació per fotogra-
mes clau o keyframes) no és gaire difícil transmetre una animació d’un programari
a un altre. La raó és que són tècniques molt establertes i compartides per un ampli
ventall de programaris, així que al llarg del temps s’ha fet un esforç per trobar
formats de dades comuns. En canvi, quan es fan servir tècniques avançades per a
una animació (per exemple, una simulació física) sovint no es pot transmetre amb
tanta facilitat (vegeu la figura 1.15), ja que hi ha fortes diferències en la forma com
es treballa amb un programari i un altre, a més d’una forta competència entre els
diferents fabricants. Aquests factors dificulten trobar formats comuns.

Figura 1.15. Interoperativitat amb tècniques avançades

Tot i això, quan diferents aplicacions independents són del mateix propietari,
aquest fa un esforç perquè puguin intercanviar animacions tant creades amb
tècniques comunes com avançades, encara que continuen havent-hi limitacions.

Eines per millorar la interoperativitat

Per facilitar l’intercanvi d’animacions entre aplicacions tenim dues eines princi-
pals: el cuinat i els formats de fitxers comuns.

Cuinat
El cuinat, o baking, consisteix a reinterpretar una animació produïda amb una
tècnica complexa com si hagués estat produïda amb una altra de més simple.

Cuinat d’una simulació de físiques

En el cuinat d’una simulació de físiques per produir fotogrames clau (keyframes) que
representen exactament la mateixa animació (vegeu la figura 1.16), aquests fotogrames
es poden transmetre a una altra aplicació per continuar-hi treballant.
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Cal recordar que sempre hi
ha un format de fitxer propi

de l’aplicació que guarda
totes les dades, siguin de

tècniques comunes,
avançades o de qualsevol

altre tipus.

Figura 1.16. Cuinat

Normalment tots els programaris que implementen tècniques avançades disposen
d’una opció per cuinar les animacions com si haguessin estat fetes amb tècniques
comunes. Això permet transmetre aquestes animacions a un altre programari i fer
ajustos fins per acabar d’adaptar l’animació a les necessitats.

A canvi, cal tenir en compte que el cuinat és un procés destructiu, ja que en
cuinar les animacions es perd l’opció de continuar modificant-les amb la tècnica
utilitzada (vegeu la figura 1.16). Per exemple, si cuineu una simulació de físiques
en fotogrames clau ja no podreu modificar la simulació de físiques, només ajustar-
la.

Així doncs, la recomanació és deixar-ho sempre com a pas final i conservar en la
mesura que sigui possible les dades de l’animació inicial, per si cal tornar enrere.

Formats de fitxers comuns
Una altra opció per intercanviar animacions entre programaris és utilitzar alguns
formats de fitxer que han esdevingut estàndard per transmetre-les (vegeu la figura
1.17). Aquests fitxers quasi sempre permeten transmetre animacions produïdes
amb tècniques comunes. Per a tècniques avançades cal consultar la documentació
disponible, per saber si les admeten o no.

Figura 1.17. Fitxer comú

Quan s’exporten les dades d’una animació a un format de fitxer comú pot passar
que algunes es conservin i d’altres es perdin si el fitxer no les admet. En aquest cas
una solució és cuinar l’animació abans d’exportar-la, tot i que es perd la possibilitat
de modificar els paràmetres utilitzats per generar-les. Sovint els formats de fitxer
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també imposen algun tipus de limitació sobre aspectes com la longitud màxima
del nom d’un objecte o la duració màxima que pot tenir una animació.

Flux de treball

Una vegada avaluades les opcions i seleccionat el programari i maquinari necessari
per a un projecte, es crea un pipeline de treball.

El flux de treball o pipeline es pot veure com una espècie de cadena de
muntatge formada per tot el programari utilitzat en un projecte juntament
amb les rutes que segueixen les dades a través seu.

Es pot representar com un graf, on cada node és un programa i cada aresta, una
operació d’exportació o importació, tal com presenta la figura 1.18.

Figura 1.18. Flux de treball

És important fer proves i estudiar també les diferents opcions per exportar i
importar dades d’un programari a un altre, escollint els formats de fitxer més
adients i els punts per a les operacions de cuinat fins a trobar la millor forma que
les dades circulin pel flux de treball.

Cas pràctic

Al següent vídeo podeu veure un cas real on s’ha de formar un flux de treball o
pipeline entre els programaris Maya i Unity3D. Observeu les dificultats que poden
sorgir i el paper dels fitxers de format comú i el cuinat:
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És important insistir en la
diferència entre direcció i

sentit. En el llenguatge
habitual no es distingeix

entre direcció i sentit,
mentre que

matemàticament sí que hi
ha diferència.

https://player.vimeo.com/video/246937602

1.2 Espai 3D

Tot i que la producció d’animacions és un treball artístic, cal conèixer alguns
fonaments teòrics i de càlcul sobre els espais 3D.

1.2.1 Sistema de referència

Cadascuna de les direccions en què l’usuari es pot moure de forma independent
és una dimensió. Vegeu la figura 1.19.

Figura 1.19. Dimensions

En un espai d’una dimensió només hi ha una direcció per moure’s independent-
ment, que és una recta. Vegeu la figura 1.20.

Figura 1.20. Direcció

Dins d’una direcció hi ha dos sentits, el positiu i el negatiu, que depenen d’on es
miri dins de la recta. Vegeu la figura 1.21.

Figura 1.21. Sentits

https://player.vimeo.com/video/246937602
https://player.vimeo.com/video/246937602
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Una vegada definits els sentits, se situa un punt d’origen. Vegeu la figura 1.22.

Figura 1.22. Origen

Una vegada definits els sentits i el punt d’origen, es fixa una escala que defineixi
quina longitud tenen les unitats en aquesta dimensió, Vegeu la figura 1.23.

Figura 1.23. Unitats

Un cop tenim aquests elements, l’usuari pot situar-se a qualsevol punt d’aquesta
dimensió fent servir un número anomenat coordenada. Vegeu la figura 1.24.

Figura 1.24. Coordenades

Matemàticament, la forma més adequada d’establir l’escala i el sentit positiu és
utilitzar un vector, tal com podeu veure a la figura 1.25, que es defineix com una
quantitat que apunta dins una direcció en un sentit concret. Aquest vector se situa
a l’origen i, dins de l’escala, és unitari, és a dir, té longitud 1.

Figura 1.25. Vector

En un espai de més d’una dimensió aquestes operacions s’han de fer per a cada
una, i això dona un vector per a cada direcció.

El conjunt dels vectors unitaris per a les diferents dimensions s’anomena base. Si
dins d’aquesta base els vectors són independents, és a dir, no se’n pot obtenir un
combinant els altres, es diu que la base és ortonormal. En aquest cas els vectors
formen angles de noranta graus entre ells, com en la figura 1.26. Aquest és el tipus
més comú de base en animacions a l’espai 3D.
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Figura 1.26. Base ortonormal

Quan a la base s’afegeix un punt d’origen comú per a totes les dimensions, apareix
un sistema de referència (vegeu la figura 1.27).

Figura 1.27. Sistema de referència

1.2.2 Coordenades de posició

En un sistema de referència s’hi situa qualsevol punt a l’espai amb les seves
coordenades respecte al sistema de referència. Aquestes coordenades consten d’un
número per dimensió multiplicat pel vector corresponent de la base i el resultat se
suma al punt d’origen. Vegeu la figura 1.28.

Figura 1.28. Coordenades 3D
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Les coordenades per si mateixes no ens serveixen per situar un punt a l’espai,
sinó que són les coordenades interpretades en el sistema de referència el
que ens permet situar el punt.

1.2.3 Coordenades d’orientació

A l’hora de situar objectes dins d’un espai, a més de la seva posició, és necessària
una forma de definir la seva orientació, és a dir, cap a on mira l’objecte. Per això
s’han de definir unes coordenades d’orientació, com en l’objecte de la figura
1.29.

Figura 1.29. Objecte orientat

En el cas d’un espai de dues dimensions, que és el cas mínim, n’hi ha prou amb
una coordenada, l’angle que forma respecte a l’eix horitzontal, com en la figura
1.30.

Figura 1.30. Coordena-
des de posició i orientació

Com en el cas de la posició, es pot definir un sentit positiu i negatiu de l’orientació.
Vegeu la figura 1.31.
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Figura 1.31. Sistema de
referència per a l’orientació

Les coordenades de rotació a l’espai 3D presenten força particularitats, però en
general cal un angle per eix. Vegeu la figura 1.32.

Figura 1.32. Orientació a l’espai 3D

1.2.4 Ampliació de conceptes

Per ampliar els conceptes de sistema de referència i coordenada i comprendre
millor com opera amb la geometria dels objectes un programari gràfic 2D/3D,
vegeu aquest vídeo en dues parts:

Primera part:

https://player.vimeo.com/video/246937501

Segona part:

https://player.vimeo.com/video/246937548

https://player.vimeo.com/video/246937501
https://player.vimeo.com/video/246937501
https://player.vimeo.com/video/246937548
https://player.vimeo.com/video/246937548
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Els nodes que no estan
emparentats amb cap altre
node es consideren
emparentats amb l’escena.

1.3 Finestres comunes

A pràcticament tot el programari d’animació 3D es poden reconèixer una sèrie
de finestres i panells comuns. Aquestes finestres es fan servir sobretot en les
anomenades tècniques comunes.

1.3.1 Graf d’escena i jerarquia

En general les dades que fa servir un programari d’animació 3D cal pensar-les com
un graf, és a dir, una sèrie de nodes que contenen informació i que es connecten
amb altres nodes establint relacions (vegeu la figura 1.33). Per exemple, un node
de física pot connectar-se amb tots els cossos que simula.

Figura 1.33. Graf d’escena

Dintre d’aquestes relacions n’hi ha una en particular que és l’emparentament, que
permet organitzar alguns d’aquests nodes com una jerarquia (vegeu la figura 1.34),
de manera que cada node té un pare o ascendent i un o més fills. Les operacions
bàsiques que ofereix la finestra de jerarquia són emparentar nodes, és a dir, establir
quin és el pare d’un node concret, i desemparentar-los.

Figura 1.34. Emparentament

És important notar que des del punt de vista de l’animació en general pot resultar
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problemàtic fer animacions on la jerarquia es modifiqui dinàmicament, és a dir,
que un objecte canviï o perdi el pare durant l’animació. Típicament, una vegada
establerta una jerarquia, aquesta és fixa durant tota l’animació.

Personatge que llença un objecte

En una animació on un personatge porta un objecte a la mà que vol llençar, en el moment
en què llença l’objecte ja no interessa que es mantingui la relació jeràrquica amb el pare,
tal com podeu veure en la figura 1.35.

Figura 1.35. Jerarquia dinàmica

Tot i això, hi ha eines i trucs per resoldre casos com aquest. Per exemple, amb un tipus
de restricció especial que simuli que l’objecte està emparentat o bé treballant amb dos
objectes idèntics, un d’emparentat i l’altre no, i amagar o mostrar el que convingui en cada
moment.

1.3.2 Editor de fotogrames clau (’keyframes’)

Una de les eines més bàsiques en qualsevol programari d’animació 3D és la fines-
tra per editar els fotogrames clau (keyframes). Des d’aquesta finestra s’estableix
com han d’evolucionar els valors de les propietats al llarg del temps (vegeu la
figura 1.36) que finalment donen lloc a l’animació.
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Figura 1.36. Editor de fotogrames clau

Les operacions bàsiques que permet aquesta eina són:

• Afegir/treure les propietats que s’han d’animar.

• Desplaçar-se a un fotograma concret amb la línia de temps.

• Afegir/treure un fotograma clau (donar un valor concret a una propietat
en un moment del temps).

• Establir quin tipus d’interpolació es vol aplicar a la propietat a l’hora de
calcular els valors intermedis (vegeu la figura 1.37).

• En alguns tipus d’interpolació, a més, ajustar les tangents de la corba
d’interpolació per fer un ajust més fi.

• En el cas de les rotacions, a més, seleccionar si han de fer servir angles
d’Euler o quaterns.
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En l’apartat “Els
fotogrames clau i

l’animació en 3D” de la
unitat “Animació

d’elements 3D” s’analitza
extensament la

interpolació.

Figura 1.37. Canvi de tipus d’interpolació

La interpolació que pateixen les propietats entre fotogrames clau (keyframes) pot
ser de diferents tipus. Segons el programari, poden ser uns tipus o uns altres.
Alguns exemples en la figura figura 1.38 són:

• Interpolació constant: no hi ha variació.

• Interpolació lineal: el valor passa d’un a l’altre mantenint un ritme d’incre-
ment constant.

• Interpolació cúbica: la interpolació fa una corba suau que no es pot
modificar.

• Interpolació per spline: la interpolació consisteix en una corba que l’usuari
pot modificar amb punts de control.

Figura 1.38. Tipus d’interpolació
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Per tal de poder controlar-la, l’editor de fotogrames clau sol tenir una segona vista
que mostra les corbes d’interpolació, com en la figura 1.39, i segons el tipus que
sigui li permet modificar-les.

Figura 1.39. Editor de corbes

1.3.3 Editor no lineal

Hi ha una limitació amb la finestra d’edició de fotogrames clau: només permet
definir l’animació seqüencialment, és a dir, s’ha de de fer tota l’animació des del
principi fins al final, encara que alguns trossos es repeteixin.

Personatge que repeteix una animació

Per animar un personatge que fa tres salts cal tornar a fer l’animació de salt tres vegades.
Vegeu la figura 1.40.

Figura 1.40. Animació repetida

Una altra limitació és que no es poden reaprofitar diferents animacions que
afecten una part d’un objecte.

Personatge que repeteix una animació amb una part del seu cos

Si un personatge saluda amb la mà mentre camina i més endavant torna a saludar però
aturat, cal fer l’animació de la part superior del cos dues vegades, encara que probablement
sigui idèntica. Vegeu la figura 1.41.
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Figura 1.41. Animació parcial repetida

La solució a aquest problema és utilitzar un editor no lineal. L’editor no
lineal és com un gran mesclador on, una vegada definides les animacions amb
l’editor de fotogrames clau, s’estableix quines animacions i en quin moment es
reproduiran.

Això permet, entre altres avantatges, reproduir diverses vegades un tros d’anima-
ció en diferents punts. Vegeu la figura 1.42.

Figura 1.42. Animació repetida amb editor no lineal

En aquests editors, a més, es poden definir pistes per aplicar les animacions a
diferents parts d’un mateix objecte. Vegeu la figura 1.43.

Figura 1.43. Animació parcialment repetida amb editor no lineal
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1.4 Utilització del so

Una animació està formada per una part visual, però també inclou un aspecte sonor
amb el qual s’estableix una interrelació. Això vol dir que hi ha dues formes de
treballar amb el so. O bé una vegada produïda l’animació aquesta se sonoritza, o
bé el so ja produït s’utilitza com a base per fer l’animació.

A més, quan s’utilitza el so cal conèixer i adoptar regles i elements d’ús habitual
al cinema, com els leitmotivs o l’ús de cues.

1.4.1 Música

La música es fa servir principalment per establir una connexió emocional amb
l’espectador per tal de poder influenciar els seus sentiments, ja que de fet és la
música i no la imatge la que s’ocupa principalment d’aquest aspecte. Aquesta
influència s’ha de fer amb delicadesa per tal de respectar també els sentiments
propis de l’espectador i no forçar-lo tampoc a sentir-se d’una certa manera.

Tipus

Podem classificar la música en dues categories: banda sonora i score.

El terme banda sonora també s’utilitza per referir-se a tot el so que acompanya
una pel·lícula, però referit a les cançons que s’utilitzen en una pel·lícula amb sentit
per si mateixes. És a dir, la banda sonora acompanya la imatge, però no té una
sincronia estreta amb aquesta imatge, a diferència de l’score.

Banda sonora

Moltes cançons de la pel·lícula The Bodyguard poden escoltar-se de manera independent,
tot i que s’utilitzen a la pel·lícula.

https://www.youtube.com/embed/3JWTaaS7LdU?controls=1

Un exemple d’ús de l’score al cinema pot ser la seqüència inicial de la pel·lícula
Raiders of the Lost Ark, on se succeeixen moltes seqüències musicals segons el
que passa a la pantalla. Visualitzeu la seqüència esmentada:

https://www.youtube.com/embed/3JWTaaS7LdU?controls=1
https://www.youtube.com/embed/3JWTaaS7LdU?controls=1
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https://www.youtube.com/embed/mC1ikwQ5Zgc?controls=1

L’score d’una pel·lícula és un conjunt de músiques que es programen per
començar i acabar en moments concrets, en sincronia amb el que succeeix
a la pantalla. Aquestes peces de música s’anomenen cues. A diferència de la
banda sonora, que pot existir prèviament, l’score es produeix conjuntament amb
l’animació.

Usos

La música en animació 3D, igual que al cinema en general, pot tenir diferents usos.
En primer lloc és una forma d’influir en l’estat emocional de l’espectador, ja que
podem tancar els ulls i continuar connectats emocionalment amb una pel·lícula,
mentre que si veiem les imatges sense so semblen fredes i distants. El so precedeix
la imatge.

En general la música té la responsabilitat de donar el to emocional a una escena.
Per aquesta raó, en el plantejament d’una animació s’han de preveure temes o
petites peces de música per a cada un d’aquests estats, entre altres. Alguns
exemples són:

• Música o tema per a seqüències d’acció

• Música o tema per a seqüències dramàtiques

• Música o tema per a moments de transició

• Música o tema per a moments de tensió

• Música o tema per a moments de tranquil·litat

Un exemple clàssic és el leitmotiv de Darth Vader a Star Wars, que també es fa
servir per identificar l’imperi galàctic:

https://www.youtube.com/embed/PyxoAkSs154?controls=1

Un altre ús de la música és identificar un personatge, lloc o concepte. Tot i que és
una tècnica que no s’utilitza d’una forma tan ostentosa com fa uns anys, la música
també s’utilitza per identificar elements de les pel·lícules. A més d’un personatge,
un lloc o un objecte, també podem tenir músiques que representen conceptes més
abstractes com l’amor o l’odi. Aquests petits fragments fàcilment identificables
s’anomenen leitmotiv.

https://www.youtube.com/embed/mC1ikwQ5Zgc?controls=1
https://www.youtube.com/embed/mC1ikwQ5Zgc?controls=1
https://www.youtube.com/embed/PyxoAkSs154?controls=1
https://www.youtube.com/embed/PyxoAkSs154?controls=1
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Tanmateix, hi ha tècniques
per fer-ho amb simulacions
físiques.

1.4.2 Efectes de so

Molts dels sons que acompanyen una seqüència transmeten el món físic en què es
produeix l’acció. Per exemple, els sorolls de passes o d’una porta al tancar-se.

Tot i que en el cinema d’acció real aquests sons es poden gravar directament durant
el rodatge, a la pràctica els sons s’afegeixen posteriorment pels artistes de foley,
que els recreen amb diferents instruments i eines.

Vegeu com a exemple la feina d’un artista de foley:

https://player.vimeo.com/video/11436985

En una animació 3D normalment no hi ha l’opció de capturar els sons. I encara que
es pugui, a la pràctica es procedeix com al cinema d’acció real i el so s’afegeix
a posteriori.

1.4.3 Veu

El voice over és tot el diàleg que es produeix en un film. A diferència del cinema
tradicional, on quasi sempre es captura durant la mateixa filmació, al cinema
d’animació 3D el voice over es produeix quasi sempre de manera independent,
en un estudi de gravació, a menys que es capturi conjuntament amb l’animació
facial.

En aquest vídeo veieu diferents exemples de sessions de gravació del diàleg per
animació tradicional:

https://www.youtube.com/embed/sn_30o3gCDg?controls=1

I al següent vídeo, visualitzeu un exemple de captura conjunta de veu i animació
facial, tot i que no és el cas habitual fora de grans produccions:

https://www.youtube.com/embed/NooE3E6Dsh8?controls=1

https://player.vimeo.com/video/11436985
https://player.vimeo.com/video/11436985
https://www.youtube.com/embed/sn_30o3gCDg?controls=1
https://www.youtube.com/embed/sn_30o3gCDg?controls=1
https://www.youtube.com/embed/NooE3E6Dsh8?controls=1
https://www.youtube.com/embed/NooE3E6Dsh8?controls=1
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Vegeu exemples pràctics
en l’apartat de “Càmeres i
rutes de moviment” de la

unitat “Animació
d’elements 3D”.

1.4.4 Integració

En general hi ha dues possibilitats per integrar so i animació: es produeix primer
el so i es fa l’animació amb el so de base (vegeu la figura 1.44) o bé es produeix
l’animació primer i se sonoritza després.

Figura 1.44. Animació a partir del so

L’eina principal per fer això és l’editor no lineal, amb el qual, a més de situar les
animacions dels diferents personatges, se situen els clips amb les músiques, tant
si formen part de la banda sonora com especialment si formen part de l’score, ja
que aquests han de començar i acabar en punts concrets, tal com podeu veure en
la figura 1.45.

Figura 1.45. Afegir ’score’ amb editor no lineal

En cas que l’score ja estigui compost, el procés és a la inversa: primer cal afegir-
lo a l’editor i després compondre l’animació d’acord amb aquest. L’editor
normalment ofereix una simulació en viu de la sonorització.

L’editor de fotogrames clau també pot oferir l’opció d’afegir un clip de so per fer
la sincronització labial (lip sync) a partir del diàleg que s’ha d’animar. Vegeu la
figura 1.46.
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Figura 1.46. Sincronització labial

Quant als efectes de so, es poden afegir a l’editor no lineal, per sincronitzar-los
amb l’animació (vegeu la figura 1.47) o es pot produir tota l’animació i fer la
sonorització a partir d’aquesta.

Figura 1.47. Efectes de so
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Trobareu una definició
d’aquests conceptes a la
secció “L’espai 3D” de
l’apartat “El programari
d’animació 3D”. Convé
que us el llegiu abans
d’abordar aquest apartat.

2. Tècniques de moviment, rotació i escalat d’objectes

Presentem els sistemes de coordenades amb què treballa Maya així com les eines
per situar objectes amb precisió dins d’aquests sistemes.

Per poder seguir correctament les indicacions d’aquest apartat heu de fer
servir la versió 2017 de Maya.

2.1 Espais de coordenades

Maya té tres sistemes principals de coordenades anomenats espais. Per defecte
tots els sistemes són dextrogirs i l’eix vertical és l’Y.

1. Espai món (world space): correspon al sistema de coordenades global de
l’escena, és a dir, el que està situat al punt (0, 0, 0) (vegeu la figura 2.1 punt
1). Aquest sistema no es pot moure.

Figura 2.1. Espai món

2. Espai d’objecte (object space) correspon al sistema de coordenades propi de
l’objecte, que té el seu origen al punt de pivot (vegeu la figura 2.2 punt 1) . Aquest
sistema acompanya tots els moviments de l’objecte i les coordenades dels vèrtexs
es defineixen respecte a aquest (vegeu la figura 2.2 punt 2).
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Figura 2.2. Espai d’objecte

3. Espai local (local space): sistema de coordenades que té l’origen en el sistema
de referència d’objecte del pare a la jerarquia. Per als objectes que no tenen pare
a la jerarquia aquest sistema és l’espai món (vegeu la figura 2.3).

Figura 2.3. Espai local

Amb les diferents eines de transformació d’objectes l’efecte obtingut és
diferent segons el sistema de referència usat.

2.2 Transformacions

El terme transformació és una forma de resumir les coordenades que serveixen
per situar un cos a l’espai, és a dir, translació, rotació i escalat.
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Aquestes coordenades es poden consultar seleccionant un objecte i obrint
l’editor d’atributs a Windows> General Editors> Attribute Editor en la primera
pestanya (figura 2.4 punt 1), sota la categoria Transform Attributes (figura 2.4 punt
2).

Figura 2.4. Atributs de transformació

A Maya hi ha eines per moure, girar i escalar un objecte. S’anomenen globalment
eines de transformació.

2.2.1 Translació

Dins del llenguatge de Maya, la translació és el desplaçament que té un objecte
respecte a l’espai món o respecte a l’espai d’objecte del pare, si forma part d’una
jerarquia. És a dir, les seves coordenades a l’espai de coordenades local.

Per desplaçar un objecte a una nova posició cal seleccionar-lo i activar l’eina
Moure. Aquesta eina es pot activar prement la icona al menú Modify> Transfor-
mation tools> Move tool o amb la drecera de teclat W.

Una vegada activada, l’objecte es desplaça arrossegant qualsevol dels eixos amb
el botó esquerre del ratolí (figura 2.5 punt 1) o al pla XY, ZY o XZ arrossegant
els manipuladors en forma de quadre (figura 2.5 punt 2).

Figura 2.5. Moure un objecte
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En fer-ho, canvia l’atribut Translation en l’editor d’atributs figura 2.6.

Figura 2.6. Atribut translació

Per a un control més precís sobre el moviment, es treballa des del panell de Tool
Settings, amb la icona corresponent (vegeu la figura 2.7) o al menú Windows>
General editors> Tool settings.

Figura 2.7. Configuració d’eines

Part superior dreta de la finestra de Maya

Dins d’aquest panell i amb l’eina de moure seleccionada es pot establir l’espai
de coordenades s’utilitzarà (vegeu la figura 2.8). Els eixos de l’objecte canvien, i
s’alineen amb el sistema escollit.

Figura 2.8. Selecció d’espai

Si seleccioneu World, els eixos s’alineen amb l’espai de coordenades món (vegeu
la figura 2.9). Això permet moure l’objecte seguint l’eix X, Y o Z globals. Aquesta
opció és adequada, per exemple, per situar un objecte en un escenari.

Figura 2.9. Eixos alineats amb ’World’
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Vegeu les explicacions
sobre la rotació en la
secció “L’espai 3D” de
l’apartat “El programari
d’animació 3D”.

Si seleccioneu Object, els eixos s’alineen amb el sistema de referència de l’espai
d’objecte (vegeu la figura 2.10). Això permet moure l’objecte al llarg dels seus
propis eixos. És adequat quan l’objecte ja està orientat d’una certa forma i
l’usuari vol situar-lo desplaçant-se respecte a aquestes direccions. Per exemple,
un esquiador situat en un pendent i s’ha de moure endavant o enrere, però amb la
inclinació donada.

Figura 2.10. Eixos alineats amb ’Object’

Si seleccioneu Parent, els eixos s’alineen segons el sistema de referència de l’espai
local, és a dir, el sistema de referència del pare de l’objecte a la jerarquia o l’espai
món, si l’objecte no està emparentat (vegeu la figura 2.11, on el cub és fill a la
jerarquia de l’extrem del braç articulat). Això pot servir per moure una peça en
la direcció de l’objecte al qual pertany. Per exemple, la vara d’un trombó que es
desplaça sempre en la mateixa direcció.

Figura 2.11. Eixos alineats amb ’Parent’

2.2.2 Rotació

La rotació té algunes particularitats però aquestes es presenten a l’hora d’animar
els objectes i no ens afecten gaire a l’hora d’orientar-los a l’escena.
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Per girar un objecte, una vegada seleccionat cal activar l’eina de girar. Per fer-ho
s’ha de seleccionar la icona de girar, anar al menú Modify> Transformation tools>
Rotate tool o bé prémer la drecera de teclat E.

El manipulador de rotació mostra un cercle per a cada eix que s’arrossega amb
el botó esquerre del ratolí, tal com podeu veure en la figura 2.12 punt 1. També es
pot arrossegar a qualsevol punt de l’esfera a part dels cercles (vegeu la figura 2.12
punt 2) per rotar lliurement.

Figura 2.12. Eina de girar

En fer-ho es veu en els atributs de transformació de l’objecte com canvien les
coordenades de rotació, tal com passa en la figura 2.13. Aquestes coordenades
sempre representen angles d’Euler i sempre estan definides en l’espai local, és
a dir, els angles representen rotacions respecte al sistema de referència del pare o
respecte al sistema de referència del món si l’objecte no està emparentat.

Figura 2.13. Atributs de rotació

Igual que amb l’eina de moure, es pot canviar l’espai de coordenades utilitzades
als Tool Settings (vegeu la figura 2.14).

Figura 2.14. Selecció de l’espai de rotació

Si seleccioneu World, els eixos de rotació s’alineen amb els eixos de món i es pot
girar l’objecte respecte a aquest sistema (vegeu la figura 2.15). Això permet fer
girs en les direccions X, Y i Z globals. Seria adequat, per exemple, per donar
l’orientació inicial a un avió suspès a l’aire.
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Observeu que les dreceres
W, E i R, corresponents a
moure, rotar i escalar, són
contigües al teclat.

Figura 2.15. Eixos de rotació alineats amb ’World’

Si seleccioneu Object, els eixos de rotació s’alineen amb els eixos propis de
l’objecte (vegeu la figura 2.16). Això permet la rotació respecte a la seva pròpia
orientació. Així, per exemple, es pot fer que un avió rodi sobre si mateix sense
variar la seva direcció.

Figura 2.16. Eixos de rotació alineats amb ’Object’

2.2.3 Escalat

L’operació d’escalat magnifica o disminueix la base de l’espai de coordenades,
de manera que en interpretar les coordenades dels vèrtexs aquests se situen en un
espai més ample en el primer cas i més estret, en el segon.

Per escalar un objecte a Maya se selecciona i es prem la icona d’escalat, o bé es
fa des del menú Modify> Transformation Tools> Scale tool. També s’utilitza la
drecera de teclat R.

Una vegada activada l’eina, es pot arrossegar el manipulador de l’eix a escalar
(figura 2.17 punt 1), escalar sobre el pla XY, YZ o XZ (figura 2.17 punt 2) o
bé aplicar un escalat uniforme sobre tots tres eixos arrossegant el manipulador
central (figura 2.17 punt 3).
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Figura 2.17. Eina d’escalat

En fer-ho, els atributs corresponents a scale canvien a l’editor d’atributs (vegeu la
figura 2.18). L’escala original es representa com a 1,1,1. Si les tres coordenades
d’escala són iguals, es tracta de l’escalat isotròpic i si són diferents, escalat
anisotròpic.

Figura 2.18. Atributs d’escalat

A Windows> General Editors> Tool Settings es pot seleccionar respecte a quin
espai de coordenades es vol fer l’escalat (vegeu la figura 2.19).

Figura 2.19. Selecció d’espai d’escalat

Si seleccioneu World, els manipuladors d’escalat s’alineen respecte a l’espai de
coordenades món (vegeu la figura 2.20) i es pot escalar l’objecte en qualsevol de
les tres direccions del sistema de referència global.
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Figura 2.20. Eixos d’escalat alineats amb ’World’

Si seleccioneu Object, els manipuladors d’escalat s’alineen respecte a l’espai de
coordenades d’objecte (vegeu la figura 2.21). Això permet escalar-lo respectant-
ne l’orientació.

Figura 2.21. Eixos d’escalat alineats amb ’Object’

Si seleccioneu Parent i l’objecte forma part d’una jerarquia, els manipuladors
d’escalat s’alineen segons l’espai de coordenades local (vegeu la figura 2.22), és
a dir, l’espai de coordenades del pare o en cas que l’objecte no estigui emparentat
amb l’espai món.

Figura 2.22. Eixos d’escalat alineats amb ’Parent’

L’esfera és filla a la jerarquia de l’extrem del braç articulat
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Escalats no isotròpics fora de l’espai local

Maya, com la majoria de programari 3D, té una limitació que consisteix en el fet
que les coordenades d’escala de l’editor d’atributs són sempre respecte a l’espai
d’objecte, encara que l’escalat sigui respecte a l’espai món o al del pare.

Això té una conseqüència important:

Maya només pot emmagatzemar un escalat anisotròpic si es fa respecte
a l’espai d’objecte.

Vegeu-ho amb un exemple amb un objecte qualsevol, per exemple, una esfera.

Exemple d’escalat no isotròpic

Situem l’esfera en una orientació qualsevol i l’escalem respecte al seu eix Y en l’espai
d’objecte. Vegeu la figura 2.23.

Figura 2.23. Escalat anisotròpic d’una esfera

Si desplaceu l’esfera a una altra posició i orientació, podeu canviar la seva escala en Y
respecte a l’espai objecte sense problemes. Vegeu la figura 2.24.

Figura 2.24. Esfera desplaçada

De fet, podeu tornar a recuperar l’esfera original si restabliu l’escala a 1,1,1. Vegeu la figura
2.25.
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Si no veieu la línia
d’ordres, podeu activar-la
a Windows> UI Elements>
Command Line.

Això és un exemple del
concepte de cuinat
exposat en l’apartat “El
programari d’animació
3D”.

Figura 2.25. Recuperació de la forma original de l’esfera

Si repetiu el mateix procés des del principi, però fent el primer escalat amb l’espai World
seleccionat a Tool settings, trobeu que l’esfera s’escala respecte a l’eix Y global. Vegeu
la figura 2.26.

Figura 2.26. Escalat amb espai ’World’

Apareix un avís a la línia d’ordres, situada a la part inferior de la finestra (vegeu la
figura 2.27). Aquest avís indica que Maya ha cuinat l’escalat als components
de l’objecte, és a dir, que ha modificat les coordenades de la llista de vèrtexs
de l’objecte per tal que reflecteixin el canvi, ja que a causa de la forma com
emmagatzema l’escalat, és l’única opció que té.

Figura 2.27. Avís

Dit d’una altra manera, l’objecte ha quedat deformat. Si el traslladeu a una altra
posició i orientació i torneu a fer un escalat respecte al sistema món, possiblement
el que aconseguireu serà deformar encara més l’objecte. Vegeu la figura 2.28.
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Figura 2.28. Esfera deformada

En conseqüència, tot i que es pot intentar una aproximació, amb aquest tipus
d’escalat no es pot recuperar la forma original de l’objecte. Vegeu la figura
2.29.

Figura 2.29. Intent de recuperar la forma original

Si observeu les coordenades d’escala de l’objecte, veureu que aquestes no han
variat amb els escalats aplicats en la figura 2.30.

Figura 2.30. Coordenades d’escala de l’esfera

Aquest problema no apareix en l’escalat isotròpic, ja que en aquest cas l’orientació
dels eixos del sistema de referència no hi influeix i Maya pot emmagatzemar
l’escalat com si s’hagués fet en l’espai local. Vegeu la figura 2.31.
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Vegeu les explicacions
sobre el reinici dins
d’aquest mateix apartat, a
la secció “Congelar i
reiniciar”.

Figura 2.31. Escalat isotròpic en espai ’World’

Escalat en jerarquies d’objectes

Quan es treballa amb objectes que formen part d’una jerarquia cal tenir en compte
que els fills hereten la transformació dels pares, és a dir, si canvieu la posició o
si roteu el pare indirectament traslladeu o roteu els fills. El mateix succeeix amb
l’escalat.

L’escalat té una particularitat. Amb l’escalat anisotròpic els fills hereten un espai
“deformat”, és a dir, que unes dimensions són més amples que les altres.

Això té com a conseqüència que si un dels objectes d’una jerarquia té un escalat
anisotròpic, en girar qualsevol dels fills aquests s’estiren o s’encongeixen més en
unes direccions que en d’altres, i es veuen deformats, com en la figura 2.32.

Figura 2.32. Escalat anisotròpic en jerarquia

D’esquerra a dreta: esfera filla de l’extrem d’un braç articulat, escalat anisotròpic del pare de l’esfera, esfera deformada en girar.

Si s’aplica un escalat isotròpic, els fills hereten l’escalat del pare i es veuen més o
menys grans, però no pateixen cap tipus de deformació, com en la figura 2.33.

Normalment quan s’aplica un escalat anisotròpic a un objecte que forma part
d’una jerarquia és perquè es busca canviar la seva forma, no perquè els fills
l’heretin.

Una possible solució a aquest problema és fer un reinici de la transformació.
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Figura 2.33. Escalat isotròpic en jerarquia

D’esquerra a dreta: esfera filla de l’extrem d’un braç articulat, escalat isotròpic del pare de l’esfera, l’esfera no es deforma en girar.

Reflectir objectes

Tot i que no és una operació bàsica, podeu utilitzar un escalat amb valors negatius
per fer un reflex de l’objecte. Vegeu la figura 2.34.

Figura 2.34. Objecte original

Per fer això, activeu l’eina d’escalat, seleccioneu a Tool Settings l’espai d’objecte i
arrossegueu el manipulador fins aconseguir un escalat negatiu en l’eix on vulgueu
el reflex. Vegeu la figura 2.35.

Figura 2.35. Objecte reflectit
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Tot i que Maya fa les correccions adequades, cal tenir en compte que
els escalats negatius poden portar errors amb la il·luminació o amb
l’orientació de les cares, que poden quedar mirant cap endins. Això és
especialment important cuidar-ho si s’han d’exportar els models a algun altre
programari.

2.3 Coordenades

Moltes vegades és necessari un control molt precís de les coordenades dels
objectes, així que cal saber què representen exactament les coordenades de trans-
formació i cal conèixer quins mecanismes hi ha per introduir-les numèricament,
reiniciar-les o copiar-les d’un objecte a un altre.

2.3.1 Interpretació

Les coordenades de transformació d’un objecte es troben dins la categoria Trans-
form, a la primera pestanya de l’editor d’atributs (vegeu la figura 2.36).

Figura 2.36. Interpretació de les coordenades

La coordenada translate és el desplaçament de l’objecte en l’espai local, és a dir,
representa el desplaçament en X, Y i Z respecte a l’espai d’objecte del seu pare,
si forma part d’una jerarquia, o respecte a l’espai món, si no està emparentat.

La coordenada rotate s’interpreta com la rotació de l’objecte en l’espai local, és
a dir, la rotació en X, Y i Z respecte al seu pare, si forma part d’una jerarquia,
o respecte a l’espai món, si no està emparentat. La rotació s’expressa en forma
d’angles d’Euler, tot i que internament Maya pot transformar-los en quaterns per
fer els càlculs.

Observeu que sota les coordenades de transformació, Maya dona l’opció d’inter-
pretar els angles d’Euler en un altre ordre (vegeu la figura 2.37), tot i que no és
recomanable fer-la servir llevat que sigui necessari.
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Observeu que un objecte
d’escala 0, tot i no ser

visible, comporta que Maya
faci alguns càlculs

igualment. Sempre que
sigui possible, és preferible

desactivar l’objecte.

Figura 2.37. Selecció de
l’ordre dels eixos de gir

La coordenada scale s’interpreta com els factors d’escala a cada eix en l’espai
local, és a dir, partint de l’escala del pare, si l’objecte està emparentat, o de l’escala
de l’espai món, que és u per cada eix, en cas contrari.

Els valors de l’escala en cada eix tenen aquests efectes:

• Una escala u no té efecte.

• Una escala zero fa que l’objecte no sigui visible.

• Una escala entre zero i u fa que l’objecte empetiteixi.

• Una escala més gran que u fa que l’objecte creixi.

• Una escala negativa provoca que l’objecte es vegi reflectit.

Unitats

Tot i que Maya ens presenta un espai abstracte, les coordenades de translació de
l’objecte tenen una equivalència física. Per defecte, representen centímetres. Po-
deu triar unes unitats diferents si aneu al menú Windows> Settings> Preferences>
General i obriu la categoria Settings, com en la figura 2.38.

Figura 2.38. Selecció d’unitats de distància

Al començament d’un projecte és important triar bé les unitats. Si treballeu
amb peces petites, és adequat triar centímetres o mil·límetres i, si feu el disseny
d’un edifici, és adequat triar metres.

Hi ha diferents raons per fer això:

1. Per comoditat, ja que amb unitats inadequades es treballa amb nombres
massa grans o massa petits que costa de visualitzar.

2. Perquè les simulacions físiques donen resultats diferents en funció de
l’escala real que representa l’escena. No té el mateix comportament físic
una roca amb un radi d’uns metres que una pedra d’uns pocs centímetres.
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L’eina per introduir les
coordenades és a la part
dreta de la barra d’eines de
Maya.

3. Per precisió numèrica, ja que l’ordinador té una capacitat limitada per
representar els nombres i pot incórrer en errors si treballa amb nombres
molt grans o molt petits, i especialment si es mesclen, és a dir, si en una
mateixa escena hi ha objectes molt grans i molt petits.

El truc del cub d’escala u

Un petit truc per solucionar això és crear un cub amb escala u als tres eixos, exportar-lo a
l’altre programari i crear en aquest programari un altre cub d’escala u. Si s’han configurat
correctament les unitats, ha de tenir exactament la mateixa mida.

La configuració de les unitats de translació també influeix en com s’interpreten
les dades del model quan s’exporta a un altre programari. Segons l’opció triada,
pot ser que el programari que rep el model en faci un escalat i es vegi massa gran
o massa petit.

Les coordenades de rotació representen angles sexagesimals (en anglès degrees).
En aquest sistema una rotació completa són tres-cents seixanta graus.

Figura 2.39. Selecció d’unitats de rotació

Al menú Windows> Settings/Preferences> General, a la categoria Settings, es
poden triar radians (vegeu la figura 2.39). Els radians són un altre sistema de
mesura d’angles on una volta completa correspon a dues vegades el nombre pi.
Aquesta representació facilita els càlculs d’alguns problemes geomètrics tot i que
per ser llegida per humans no resulta tan còmoda.

Les coordenades d’escala no tenen unitats, ja que representen la proporció entre
la mida original de l’objecte i la mida a què es vol escalar.

2.3.2 Introducció numèrica

Tot i que es poden transformar els objectes amb les diferents eines que ens ofereix
Maya, a vegades és necessari introduir uns valors precisos per a les seves
coordenades.

Per fer-ho, seleccioneu l’objecte, aneu a la categoria transform de l’editor d’atri-
buts, cliqueu sobre la coordenada a modificar i introduïu el nou valor amb el teclat.

Un altre mètode és seleccionar l’eina de moure, rotar o escalar al menú Modify>
Transformation Tools i introduir les coordenades al quadre d’entrada de text (input
box). Vegeu la figura 2.40.
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Les coordenades amb
valors inicials són zero per a
la posició i la rotació i u per

a l’escala.

Figura 2.40. Quadre d’entrada de text (’input box’)

Si cliqueu sobre la icona de l’input box (vegeu la figura 2.41), ofereix dues opcions
per a la transformació.

Figura 2.41. Accés a les opcions

Si seleccioneu Absolute transform, les coordenades introduïdes s’interpreten
respecte a l’espai món, és a dir, el sistema de referència global. Si seleccioneu
Relative transform, les coordenades s’interpreten en l’espai local, és a dir, com si
editéssiu els seus valors a l’editor d’atributs.

2.3.3 Congelar i reiniciar

Tot i que són conceptes semblants, les operacions de congelar i reiniciar tenen unes
implicacions diferents que cal entendre per saber quan aplicar-ne una o altra.

Congelar la transformació d’un objecte vol dir donar els valors inicials a les
coordenades de transformació, però mantenint els vèrtexs a la mateixa posició.

Reiniciar la transformació vol dir només donar els valors inicials a les coorde-
nades de transformació. Si s’ha transformat l’objecte, els vèrtexs retornen a la
posició d’abans d’aquestes transformacions.

Per reiniciar la transformació només cal seleccionar un objecte transformat
prèviament i anar al menú Modify> Reset Transformation. Observeu que l’objecte,
partint de la seva transformació actual (vegeu la figura 2.42 punt 2), recupera la
posició, rotació i escala inicials (vegeu la figura 2.42 punt 1).
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L’acció Reset transformation
es pot simular si l’usuari
edita aquests valors.

Figura 2.42. Efecte del reinici de coordenades

Si consulteu les coordenades a l’Attribute editor, veureu com s’han reiniciat (vegeu
la figura 2.43).

Figura 2.43. Coordenades després d’un reinici

L’efecte de la congelació és més subtil. Un objecte transformat, per exemple,
aplicant-li una rotació i escalant-lo a un eix, per congelar-lo s’ha de seleccionar i
anar al menú Modify> Freeze Transformations.

Visualment no es nota cap canvi, a menys que activeu l’eina de moure i seleccioneu
l’espai objecte a Tool settings. Així veureu que els eixos ara estan orientats com
si acabéssiu de crear l’objecte, com en la figura 2.44. És a dir, que no reflecteixen
les rotacions efectuades.
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Teniu una explicació sobre
la llista de vèrtexs a la
secció “L’espai 3D” de

l’apartat “El programari
d’animació 3D”.

En sentit estricte sí que es
pot recuperar la forma

original, fent servir el
Construction History de

l’objecte.

Figura 2.44. Efecte de la congelació

A l’esquerra: objecte abans de la congelació. A la dreta: objecte després de la congelació.

Si consulteu les coordenades de l’objecte, a més, veureu que aquestes s’han iniciat
(vegeu la figura 2.45).

Figura 2.45. Coordenades després la congelació

Maya modifica les coordenades de la llista de vèrtexs de l’objecte perquè
reflecteixin les transformacions efectuades. Això dona un objecte sense cap
transformació que té exactament la mateixa forma.

Per exemple, si partiu d’un tor i el gireu i estireu, ja no tindreu un tor sinó un
objecte nou, que té la forma d’un tor girat i estirat, ja que les coordenades dels
seus vèrtexs s’hauran modificat.

Una vegada congelat l’objecte, es pot traslladar i aplicar-li rotacions i escalats,
però a partir de la forma resultant de la congelació, és a dir, llevat que es desfaci
la congelació no es pot recuperar la forma original.

Una aplicació d’això es veu en un objecte que forma part d’una jerarquia i la
seva transformació pot provocar efectes indesitjats als fills, en concret l’escalat
anisotròpic, que pot produir deformacions en aplicar rotacions als fills. Vegeu la
figura 2.46.
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Per desemparentar un
objecte heu de
seleccionar-lo i anar al
menú Edit> Unparent. Per
emparentar-lo heu de
seleccionar primer l’objecte
que fa de fill i després el
que fa de pare, prement les
majúscules, i anar a Edit>
Parent.

Figura 2.46. Fill deformat per escalat anisotròpic del pare

Una forma d’adreçar aquest problema és desemparentar els fills (vegeu la figura
2.47), congelar el pare (vegeu la figura 2.48) i tornant a emparentar-los (vegeu la
figura 2.49). D’aquesta manera les transformacions fetes al pare s’apliquen a la
seva forma i aquest torna a tenir una transformació amb els valors inicials, que
resulta neutra per als fills, eliminant els possibles efectes indesitjats.

Figura 2.47. Fill desemparentat

Figura 2.48. Congelació de l’anterior pare
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Figura 2.49. Objecte emparentat de nou

La congelació i el reinici de la transformació són mecanismes semblants en
el sentit que ambdós reinicien les coordenades de l’objecte.

Però...

La congelació modifica la forma de l’objecte i el reinici no modifica la
forma de l’objecte.

2.3.4 Igualar

Si voleu que dos objectes tinguin exactament les mateixes coordenades, es
poden igualar manualment d’un a l’altre fent servir l’Attribute editor. Afortuna-
dament Maya proveeix d’una eina per fer aquesta operació de forma automàtica.

Si voleu copiar les coordenades d’un objecte a un altre heu de seleccionar primer
l’objecte destinatari i, després, l’objecte origen (vegeu la figura 2.50), és a dir,
l’objecte al qual voleu copiar les coordenades i l’objecte del qual voleu copiar-les.
Per seleccionar més d’un objecte heu de mantenir les majúscules premudes i fer
clic amb el botó esquerre del ratolí.
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Figura 2.50. Selecció d’objectes que voleu igualar

Una vegada seleccionats els objectes, aneu al menú Modify> Match transformati-
ons> Match all transforms. Observareu que l’objecte destinatari ara té exactament
les mateixes coordenades que l’objecte origen (vegeu la figura 2.51).

Figura 2.51. Objectes igualats

Podeu fer aquesta mateixa operació sobre més d’un objecte seleccionant tots els
objectes destinataris primer i l’objecte origen al final. Vegeu-ho en la figura 2.52.
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Figura 2.52. Selecció de més d’un objecte per igualar

Al menú Modify> Match transformations> Match all transforms trobareu tots els
objectes amb les mateixes coordenades, com en la figura 2.53.

Figura 2.53. Objectes igualats

Al menú Modify> Match transformations hi ha altres opcions per limitar la còpia
a la translació, rotació o escalat.

Els objectes origen i destinatari també poden formar part d’una jerarquia. Un cas
bastant comú és que l’origen formi part d’una jerarquia, però el destinatari no, com
en la figura 2.54. Seria el cas, per exemple, d’una espasa que hem de situar sobre
la mà d’un personatge.
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Figura 2.54. Selecció d’objectes per igualar en jerarquia

En aquest cas, si seleccioneu l’objecte destinatari i origen i apliqueu l’acció
Modify> Match transformations> Match all transforms observareu que l’objecte
destinatari se situa a sobre de l’objecte origen (vegeu la figura 2.55) tot i que aquest
forma part d’una jerarquia.

Figura 2.55. Objectes igualats en jerarquia

En aquest cas si voleu fer el mateix sense aquesta eina és força més complicat, ja
que les coordenades d’un objecte quan forma part d’una jerarquia són respecte a
l’espai de coordenades del pare i les d’un objecte no emparentat són respecte a
l’espai de coordenades món, de manera que no serviria copiar-les amb l’editor
d’atributs.

2.4 El punt de pivot

En l’espai d’objecte totes les translacions, les rotacions i els escalats són sobre un
punt anomenat punt de pivot. Aquest punt inicialment està centrat en l’objecte, de
manera que en girar o escalar aquestes operacions es fan des del centre de l’objecte
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(vegeu la figura 2.56).

Figura 2.56. Punt de pivot centrat

Si situeu el punt de pivot en una altra posició, el resultat d’aquestes operacions és
diferent (vegeu la figura 2.57).

Figura 2.57. Punt de pivot a una altra posició

2.4.1 Moure el punt de pivot

A Maya, si en qualsevol moment interessa situar el punt de pivot en una posició
diferent per a un objecte, es pot fer activant una eina de transformació qualsevol
al menú Modify> Transformation tools. Una vegada seleccionat l’objecte, s’ha de
mantenir premuda la tecla D. Veureu que apareix un manipulador combinat de
rotació i translació a la posició actual del pivot, com en la figura 2.58.

Figura 2.58. Manipulador del pivot

Arrossegant els diferents manipuladors podeu situar el pivot en una posició i/o
orientació diferent, com podeu veure en la figura 2.59.
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Figura 2.59. Pivot desplaçat

Si deixeu anar la tecla D i seleccioneu qualsevol de les eines de transformació al
menú, sempre que seleccioneu l’espai d’objecte als Tool settings les transformaci-
ons es fan des d’aquest punt (vegeu la figura 2.60).

Figura 2.60. Transformació des de la nova posició del pivot

Una altra operació és centrar el punt de pivot. Per fer-ho cal seleccionar l’objecte
i anar al menú Modify> Center Pivot (vegeu la figura 2.61).

Figura 2.61. Pivot centrat
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El punt de pivot també es pot manipular des dels Tool settings si seleccioneu un
objecte i activeu qualsevol eina de transformació al menú Modify> Transformation
tools (per exemple, l’eina de moure). Una vegada seleccionada l’eina, podeu obrir
els Tool settings amb Windows> General Editors> Tool Settings. Trobareu un botó
que activa el mode d’edició del pivot (vegeu la figura 2.62).

Figura 2.62. Botó d’edició del pivot

Amb aquest mode activat, podeu fer servir un manipulador combinat per situar
el pivot on vulgueu, com en la figura 2.63.

Figura 2.63. Transformació del pivot

Una vegada situat el pivot, se’n surt prement altre cop el botó d’edició del pivot,
que es troba destacat en blau (figura 2.64 punt 1). Al costat hi ha un botó per
desplaçar el punt de pivot a la seva posició inicial (figura 2.64 punt 2).
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El centre de gravetat d’un
objecte és el punt al voltant
del qual tota la seva massa
es troba uniformement
repartida.

Figura 2.64. Desactivació de l’edició del pivot

2.4.2 Seleccionar un bon punt de pivot

És molt important des del punt de vista de l’animació seleccionar un punt de pivot
adient per a cada objecte.

Per exemple, per animar un cotxe que ha de fer tombarelles o qualsevol altre
objecte que es mou lliurement, molt possiblement s’haurà de situar el pivot al
seu centre de gravetat. Vegeu la figura 2.65.

Figura 2.65. Selecció del pivot per a un
objecte que es mou lliurement

Si, al contrari, l’objecte normalment està recolzat sobre un altre (per exemple, un
gerro a sobre una taula, o un personatge que toca a terra), possiblement resultarà
més adient situar el punt de pivot al punt més baix (vegeu la figura 2.66).

Figura 2.66. Selecció del pivot per a objectes que es recolzen
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En el cas dels objectes articulats, el punt de pivot se situa al punt d’articulació.
Això és especialment important en personatges, però també per a altres tipus
d’objectes com portes o altres tipus de maquinària (vegeu la figura 2.67).

Figura 2.67. Selecció del pivot per a objectes articulats

Per defecte no es pot animar el punt de pivot durant una animació.

2.4.3 Eixos de transformació personalitzats

Tot i que no tenen relació amb el punt de pivot, durant les operacions de trans-
formació es pot activar una opció als Tool settings que ofereix una funcionalitat
molt semblant a la d’un pivot, ja que permet definir uns eixos personalitzats per
la transformació.

Per activar aquest mode heu de seleccionar l’objecte, activar una eina de transfor-
mació (per exemple, la de moure a Modify> Transformation tools> Move tool) i
obrir els Tool settings, al menú Windows> General Editors> Tool Settings. Les
opcions es despleguen en clicar la fletxeta de l’esquerra d’Axis orientation (vegeu
la figura 2.68 punt 1). Seleccioneu Custom (vegeu la figura 2.68 punt 2).

Figura 2.68. Situació de l’opció d’eixos personalitzats

Un cop seleccionada aquesta opció, podeu introduir una orientació per als eixos
personalitzats en angles d’Euler (vegeu la figura 2.69).
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Figura 2.69. Introducció d’angles per als eixos personalitzats

A l’escena veureu que els eixos de la transformació estan orientats segons els eixos
personalitzats definits (vegeu lafigura 2.70), fet que permet desplaçar, moure o
escalar l’objecte en aquestes direccions.

Figura 2.70. Aspecte dels eixos personalitzats

Si desplegueu les opcions disponibles amb la fletxeta de l’esquerra, trobareu
opcions per alinear aquests eixos personalitzats amb objectes o components com
cares o vèrtexs, com en la figura 2.71.

Figura 2.71. Opcions d’alineació d’eixos personalitzats
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2.5 ’Snapping’

En moure un objecte, de vegades és necessari que la seva posició coincideixi
exactament amb la d’algun altre objecte a escena o amb algun component, com
un vèrtex o una cara. Les eines d’snapping faciliten aquesta tasca. Les trobareu a
la barra d’eines, com podeu veure en la figura 2.72.

Figura 2.72. Eines d”snapping’

Prement el primer botó (vegeu la figura 2.72 punt 1) o la tecla X es pot fer que
en moure els objectes, arrossegant-los amb el manipulador en forma de cercle
de la intersecció dels seus eixos, es col·loquin a les interseccions de la graella.
Vegeu-ho en la figura 2.73.

Figura 2.73. ’Snapping’ amb la graella

La graella és el pla amb subdivisions que dona una referència de les dimensions i
l’orientació de l’espai de coordenades global (vegeu la figura 2.74).

Figura 2.74. Graella

Podeu modificar-ne les dimensions clicant al quadret del costat del menú Display>
Grid (vegeu la figura 2.75).
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Per crear corbes podeu fer
servir l’eina CV Curve Tool
del menú Create> Curve
Tools> CV Curve Tool.

Figura 2.75. Configuració de la graella

Prement el segon botó (vegeu la figura 2.76 punt 2) o la tecla C, podeu fer que
en moure els objectes es col·loquin sobre la corba més propera, com en la figura
2.76. Prement el tercer botó (vegeu la figura 2.76 punt 3) o la tecla V, l’objecte
s’ajusta als vèrtexs de qualsevol objecte (vegeu la figura 2.77).

Figura 2.76. ’Snapping’ amb corba

El quart botó (figura 2.76 punt 4) permet alinear un objecte amb el centre de la
geometria seleccionada i el cinquè botó permet alinear l’objecte amb els plans de
visió de les diferents càmeres definides a escena (vegeu la figura 2.77 punt 5).

Figura 2.77. ’Snapping’ amb vèrtex



Animació 2D i 3D 76 Programari d’animació 3D

2.5.1 ’Live surface’

La live surface és una forma d’snapping que permet ajustar la posició d’un objecte
a qualsevol punt de la superfície d’un altre. Per exemple, pot servir per situar un
arbre en la superfície d’una muntanya.

Per establir un objecte com a live surface es prem el sisè botó de les eines
d’snapping, com podeu veure en la figura 2.78.

Figura 2.78. Situació de l’eina ’live surface’

Una vegada seleccionat, el nom de l’objecte apareix al costat del botó (vegeu la
figura 2.79).

Figura 2.79. Objecte seleccionat com a ’live surface’

Amb un objecte establert com a live surface, es pot seleccionar qualsevol altre
objecte i desplaçar-lo per sobre del primer. Observeu com es posiciona sobre la
seva superfície en la figura 2.80.

Figura 2.80. ’Snapping’ amb ’live surface’

Quan ja no sigui necessària la live surface, es pot desactivar el mode prement
una altra vegada el botó.
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2.5.2 Increments regulars

Una altra tècnica per ajustar amb precisió la posició, rotació o escala d’un objecte
és forçar-ne l’increment regular, és a dir, d’un en un, de dos en dos o amb
qualsevol altra xifra definida com a increment.

Per activar aquesta característica heu de seleccionar una eina de transformació
al menú Modify> Transformation tools i obrir el panell de Tool settings al menú
Windows> General editors> Tool settings. Si seleccioneu l’eina de moure, en
aquest panell trobareu un conjunt d’opcions anomenat step snap (vegeu la figura
2.81).

Figura 2.81. Situació del grup d’opcions d’increment regular

Si desplegueu les opcions disponibles, en trobareu una anomenada relative (vegeu
lafigura 2.82).

Figura 2.82. Opcions d’increment regular disponibles

Si la seleccioneu, podreu definir la quantitat que voleu com a increment (vegeu
la figura 2.83).

Figura 2.83. Establir una quantitat per a l’increment regular

Una vegada definida, si moveu l’objecte es desplaça en cada eix amb aquest
increment (segons la figura 2.84). Observeu que l’objecte pren com a origen del
seu moviment la seva posició actual. És a dir que si l’objecte parteix de la posició
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1 en X i l’increment configurat és de 2, quan incrementeu la seva posició en X la
primera posició que pren és de 3.

Figura 2.84. Moviment amb increment regular

Per desactivar l’efecte step snap seleccioneu al menú l’opció off, com podeu veure
en la figura 2.82.

Els increments regulars també els trobareu en les eines de rotar i escalar.

Si seleccioneu l’eina de rotar, hi ha dues opcions al grup step snap dels Tool
settings: absolute i relative (vegeu la figura 2.85).

Figura 2.85. Opcions d’increment regular per la rotació

Si seleccioneu Absolute i definiu un increment (per exemple, 10), trobareu que
en girar l’objecte pren angles que són múltiples del valor definit, és a dir, fa
els increments de deu en deu partint de zero (vegeu-ho en la figura 2.86). Si
seleccioneu Relative, l’increment es fa partint de la rotació actual de l’objecte,
és a dir, si l’objecte parteix d’una rotació en X de 5 graus i l’increment és de 10,
la següent rotació que prendrà en girar-lo en X serà de 15 graus.
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Figura 2.86. Rotació amb increment regular

Si seleccioneu l’eina d’escalar, trobareu les mateixes opcions que per a l’eina de
rotar, amb un efecte equivalent, però aplicades sobre les coordenades d’escala
(vegeu-ho en la figura 2.87).

Figura 2.87. Escalat amb increment regular

2.6 Alineació

Una altra opció per posicionar objectes és fer que, prenent un objecte com a
referència (vegeu la figura 2.88 punt 1), els altres s’alineïn respecte d’aquest
objecte, de manera que els seus extrems quedin sobre un mateix pla (vegeu la
figura 2.88 punt 2), de manera similar a com ens situem per començar una cursa .
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Figura 2.88. Efecte d’alinear objectes

Per fer aquesta operació heu de seleccionar els objectes que voleu alinear selecci-
onant en últim lloc l’objecte pres com a referència. Una vegada seleccionats tots
els objectes, activeu l’eina Align tool al menú Modify> Align tool. A partir d’aquí,
una sèrie de controls agrupats en tres panells (vegeu la figura 2.89 punts 1 a 3), un
per cada eix de l’espai de coordenades, permeten fer diferents tipus d’alineació.

Figura 2.89. Eina d’alineació

Si us centreu en un sol dels eixos (per exemple, l’eix X), trobareu fins a cinc
formes d’alinear els objectes (vegeu la figura 2.90 punts 1 a 5).
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Figura 2.90. Manipuladors a l’eix X de l’eina d’alineació

Podeu alinear:

• Per l’extrem esquerre (figura 2.91 punt 1) i dret (figura 2.91 punt 2) de
l’objecte de referència, situant els objectes a l’exterior.

• Per l’extrem esquerre (figura 2.91 punt 3) i dret (figura 2.91 punt 4) de
l’objecte de referència, situant els objectes a l’interior.

• Al centre, respecte a l’objecte de referència (figura 2.91 punt 5).

Figura 2.91. Efectes dels diferents tipus d’alineació

Aquestes mateixes operacions es poden realitzar en qualsevol dels altres dos eixos.

2.7 Transformació proporcional

A Maya, en desplaçar, girar o escalar un conjunt d’objectes hi ha la possibilitat
que els objectes es vegin més o menys afectats segons la distància a què estiguin
situats respecte a un punt central (vegeu la figura 2.92 punt 1), de manera que, per
exemple, es desplacin més o menys a l’eix Y.
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Per simplicitat, fem
l’explicació amb objectes

situats en un sol eix.

Figura 2.92. Efecte de la transformació proporcional

L’eina per aconseguir aquest efecte és la Proportional modification tool, del menú
Modify> Transform tools> Proportional modification tool.

Per fer-la servir primer heu de seleccionar tots els objectes que voleu transformar.
Amb l’eina activada, trobareu un manipulador combinat que permet desplaçar
(figura 2.93 punt 1), girar (figura 2.93 punt 2) o escalar els objectes (figura 2.93
punt 3).

Figura 2.93. Eina de transformació proporcional

En una transformació amb el manipulador, cada objecte, en funció de la distància
a què es troba del centre del manipulador, pateix una transformació més o menys
intensa tant en la translació (vegeu la figura 2.94) com en la rotació (vegeu la
figura 2.95) o l’escalat (vegeu la figura 2.96).
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Figura 2.94. Translació proporcional

Figura 2.95. Rotació proporcional

Figura 2.96. Escalat proporcional

Si voleu més control sobre l’àrea d’influència del manipulador, podeu ajustar-la
a Tool settings, seleccionant l’eina i anant al menú Windows> General editors>
Tool settings. Des d’aquest panell també podeu canviar entre diferents tipus de
decaïment (vegeu la figura 2.97 punt 1) o falloff (en anglès).



Animació 2D i 3D 84 Programari d’animació 3D

Figura 2.97. Opcions de moviment proporcional

Si seleccioneu Linear, la influència de la transformació disminueix a un ritme
constant segons la distància, de manera que es pot representar com una línia recta
(vegeu la figura 2.98).

Figura 2.98. Opció ’Linear’

Si seleccioneu Power, la influència disminueix més lentament a prop del centre
i als extrems, seguint la forma de campana corresponent a una funció polinòmica
amb exponents (vegeu la figura 2.99).

Figura 2.99. Opció ’Power’

Si voleu fer que l’àrea d’influència (figura 2.101 punt 1) de l’eina sigui més
gran o més petita, s’ajusta el paràmetre distance cutoff de Tools settings (vegeu la
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figura 2.97 punt 2). Els objectes que quedin més enllà d’aquesta àrea no es veuran
afectats.

Figura 2.100. Limitació de distància

Figura 2.101. Efecte de la limitació de distància

Si seleccioneu l’opció Power, a més, podreu ajustar l’exponent (vegeu la figura
2.102). Això fa que la part central de la campana es concentri més o menys segons
si l’exponent és més o menys gran respectivament (vegeu la figura 2.103).

Figura 2.102. Exponent de l’opció ’Power’

Figura 2.103. Efecte de diferents exponents amb l’opció ’Power’
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Si introduïu un exponent negatiu, podeu fer que la influència s’inverteixi, de
manera que sigui més intensa com més lluny es trobi del manipulador (vegeu la
figura 2.104).

Figura 2.104. Efecte d’un exponent negatiu amb l’opció ’Power’

Finalment, podeu desplaçar el manipulador si una vegada seleccionats els
objectes i l’eina premeu la drecera D al teclat. Observareu que l’eina canvia a
una forma més simple que es deixa arrossegar a un altre punt de l’escena des del
quadre central (vegeu la figura 2.105 punt 1), els eixos (vegeu la figura 2.105 punt
2) o els diferents plans (vegeu la figura 2.105 punt 3).

Figura 2.105. Desplaçament del manipulador

Una vegada situat el manipulador, podeu fer la transformació, que prendrà com a
centre d’influència la nova posició (vegeu la figura 2.106).
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Figura 2.106. Efecte del manipulador desplaçat
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